RA4W1 Group
Bluetooth Mesh sample application

Introduction
This document describes the sample application which uses the Bluetooth® Mesh Stack. Bluetooth® Mesh Stack is the software library to which is used to build a mesh network that is compliant with Bluetooth Mesh Networking Specification and to perform many-to-many wireless communication.

In this document, the Bluetooth® Mesh is referred to as the Mesh.

For more details on how to perform the Mesh demonstration which uses this sample application, refer to "RA4W1 Group Bluetooth Mesh Startup Guide" (R01AN5847).

Target Device
RA4W1 Group

Related Documents
- Bluetooth Core Specifications (https://www.bluetooth.com)
- Mesh Profile Specification (Search for “Mesh Profile 1.0.1” in https://www.bluetooth.com)
- Mesh Model Specification (Search for “Mesh Model 1.0.1” in https://www.bluetooth.com)
- Renesas Flexible Software Package (FSP) User's Manual (R11UM0155)
- RA4W1 Group BLE sample application (R01AN5402)
- RA4W1 Group Bluetooth Mesh Startup Guide (R01AN5847)
- RA4W1 Group Bluetooth Mesh Development Guide (R01AN5849)
Contents

1. Overview ................................................................................................................................. 3
  1.1 Demo projects ...................................................................................................................... 3
  1.2 Mesh Stack features ............................................................................................................. 5
  1.3 Software Architecture ......................................................................................................... 6
  1.4 File Composition .................................................................................................................. 7
  1.5 API Specification ................................................................................................................ 7
  1.6 Operating environment ....................................................................................................... 8

2. How to use demo project ......................................................................................................... 9
  2.1 Importing demo project ...................................................................................................... 9
  2.2 Building and debugging .................................................................................................... 11

3. How to make and configure new project .............................................................................. 12
  3.1 Create a New Project ......................................................................................................... 12
  3.2 Heap and Stack configuration ............................................................................................ 15
  3.3 Clocks configuration ........................................................................................................... 16
  3.4 Add and configure MESH Stack ........................................................................................ 17
    3.4.1 Add MESH Stack in BareMetal environment ................................................................. 17
    3.4.2 Add MESH Stack in FreeRTOS environment ................................................................. 20
    3.4.3 Configure Mesh Stack .................................................................................................. 25
    3.4.4 Other Mesh Stack configuration ................................................................................... 27
  3.5 Add and configure related module .................................................................................... 32
    3.5.1 r_gpt (g_timer0) ............................................................................................................ 33
    3.5.2 r_flash_lp ....................................................................................................................... 34
    3.5.3 r_icu (g_external_irq0) ................................................................................................. 35
    3.5.4 r_gpt (g_timer1) ............................................................................................................ 36
    3.5.5 r_icu (g_ble_sw_irq) ..................................................................................................... 37
    3.5.6 r_sci_uart ...................................................................................................................... 38
    3.5.7 r_lpm .............................................................................................................................. 40
  3.6 Generate Code .................................................................................................................... 41
  3.7 Building and debugging ..................................................................................................... 41

4. How to Implement Mesh Applications ................................................................................... 42

5. Appendix ............................................................................................................................... 43
  5.1 Program Size ....................................................................................................................... 43

Revision History ....................................................................................................................... 45
1. Overview

1.1 Demo projects

Projects for the sample application accompanying this document are shown in Table 1-1.

<table>
<thead>
<tr>
<th>Project name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ekra4w1_mesh_client_baremetal</td>
<td>Client Models project for EK-RA4W1 not using FreeRTOS.</td>
</tr>
<tr>
<td>ekra4w1_mesh_client_freertos</td>
<td>Client Models project for EK-RA4W1 using FreeRTOS.</td>
</tr>
<tr>
<td>ekra4w1_mesh_server_baremetal</td>
<td>Server Models project for EK-RA4W1 not using FreeRTOS.</td>
</tr>
<tr>
<td>ekra4w1_mesh_server_freertos</td>
<td>Server Models project for EK-RA4W1 using FreeRTOS.</td>
</tr>
<tr>
<td>ekra4w1_mesh_cli_client_baremetal</td>
<td>Command Line Interface (CLI) project for EK-RA4W1 not using FreeRTOS.</td>
</tr>
<tr>
<td>ekra4w1_mesh_cli_server_baremetal</td>
<td>Command Line Interface (CLI) project for EK-RA4W1 not using FreeRTOS.</td>
</tr>
</tbody>
</table>

These projects can work on an EK-RA4W1 board.

The Server Models projects perform Server model. They receive messages from remote device (e.g. smartphone) performing Client model, then blink the board mounted LED, and display the received strings.

The Client Models projects perform Client model. They support CLI which can be accessed by using a terminal emulator (e.g. Tera Term) on a PC by connecting it with an EK-RA4W1 board via USB cable. They send messages to the remote device performing Server model by pushing the board mounted switch or by using CLI, then blink the board mounted LED, and display strings on the remote device.

![Figure 1-1 Projects overview (Server and Client)](image)
CLI projects can perform all models defined Mesh Specification. They can perform various procedures relating to the Mesh by transmitting and receiving messages using CLI.
1.2 Mesh Stack features

The Mesh Stack provides many-to-many wireless communication features which are compliant with Bluetooth Mesh Profile 1.0.1 Specification and Bluetooth Mesh Model 1.0.1 Specification. This stack supports the following features.

Bluetooth Core Mesh Profile features:

- Provisioning (both Provisioning Server and Provisioning Client)
- Access
- Upper Transport
  - Friendship (both Friend feature and Low Power feature)
- Lower Transport
- Network
  - Relay
  - Proxy (both Proxy Server and Proxy Client)
- Bearer
  - ADV Bearer
  - GATT Bearer
- Foundation Model
  - Configuration Model (both Configuration Server and Configuration Client)
  - Health Model (both Health Server and Health Client)

Bluetooth Mesh Model features:

- Generic Models
  - OnOff, Power OnOff, Power OnOff Setup
  - Level, Power Level, Power Level Setup
  - Default Transition Time
  - Battery
  - Location, Location Setup
  - Manufacturer Property, Admin Property, User Property, Client Property
- Sensor Model
  - Sensor, Sensor Setup
- Time Model
- Scene Model
  - Scene, Scene Setup
- Scheduler Model
  - Scheduler, Scheduler Setup
- Light Models
  - Light Lightness, Light Lightness Setup
  - Light CTL, Light CTL Setup
  - Light HSL, Light HSL Setup
  - Light xyL, Light xyL Setup
  - Light Control
1.3 Software Architecture

Figure 1-3 shows the software architecture using Mesh Stack.

The Mesh Stack software is composed of the followings:

- **Mesh Application**
  The Mesh Application is an application which performs features provided by the Bluetooth Mesh Stack.

- **Bluetooth Mesh Stack**
  The Bluetooth Mesh Stack is a software that provides applications with many-to-many wireless communication features which are compliant with Bluetooth Mesh Networking Specifications.

- **Bluetooth Bearer (Bearer Platform)**
  The Bluetooth Bearer is the abstraction layer that provides wrapper functions of Bluetooth Low Energy Protocol Stack.

- **Bluetooth Low Energy Protocol Stack**
  The Bluetooth Low Energy Protocol Stack (hereinafter referred to as "Bluetooth LE Stack") is the software that provides the higher layers with wireless communication features which are compliant with the Bluetooth Low Energy specifications.

A Sample program of Mesh Application is included in the demo project included in this document.

Bluetooth Mesh Stack and Bluetooth Bearer are provided as FSP.

Bluetooth LE Stack is provided as FSP.
1.4 File Composition

File composition of demo project is as follows:

```
ekra4w1_mesh_xxx_yyy
  +---ra\fsp\inc\api\n      |       r_ble_api.h
      |       rm_ble_mesh_xxx_api.h
      |       rm_mesh_bearer_platform_api.h
      +---ra\fsp\inc\instances\n          |       rm_ble_mesh_xxx.h
          |       rm_mesh_bearer.h
          |       rm_mesh_xxx.h
          +---ra\fsp\lib\r_ble\n          +---ra\fsp\lib\rm_ble_mesh\n              +---ra_cfg\fsp_cfg\n                  |       r_ble_cfg.h
                  |       rm_ble_mesh_cfg.h
              +---src\n```

To use the features provided by the Mesh Stack, the Mesh Stack must be added to a project. Regarding how to add the stack to a project, refer to Chapter 3 in this document.

1.5 API Specification

To perform the features provided by the Mesh Stack, it is necessary to use the API of the Mesh Stack. Regarding the specification of Mesh Stack API, refer to "Renesas Flexible Software Package (FSP) User's Manual (R11UM0155)".
1.6 Operating environment

Table 1-2 shows the confirmed operating environment for hardware to build and debug the demo project.

### Table 1-2 Hardware environment

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host PC</td>
<td>Windows® 10 PC with USB interface.</td>
</tr>
<tr>
<td>MCU board</td>
<td>The MCU used must support BLE functions. EK-RA4W1 [RTK7EKA4W1S00000BJ]</td>
</tr>
<tr>
<td>On-chip debugging emulators</td>
<td>The EK-RA4W1 has an on-board debugger (J-Link OB), therefore it is not necessary to prepare an emulator</td>
</tr>
<tr>
<td>USB cables</td>
<td>Used to connect to the MCU board.</td>
</tr>
</tbody>
</table>

Table 1-3 shows the confirmed operating environment for software to build and debug the demo project.

### Table 1-3 Software environment

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GCC environment</td>
<td>e² studio</td>
<td>2022-10 Integrated development environment (IDE) for Renesas devices.</td>
</tr>
<tr>
<td>GCC ARM Embedded</td>
<td>V10</td>
<td>C/C++ Compiler. (Download from e² studio installer)</td>
</tr>
<tr>
<td>Renesas Flexible Software Package (FSP)</td>
<td>V4.2.0</td>
<td>Software package for making applications for the RA microcontroller series.</td>
</tr>
<tr>
<td>SEGGER J-Flash</td>
<td>V6.86</td>
<td>Tool for programming the on-chip flash memory of microcontrollers.</td>
</tr>
<tr>
<td>Integer types</td>
<td></td>
<td>ANSI C99 &quot;Exact width integer types&quot;. These types are defined in stdint.h.</td>
</tr>
<tr>
<td>Endian</td>
<td></td>
<td>Little endian</td>
</tr>
</tbody>
</table>
2. **How to use demo project**

This chapter describes how to use the demo project included in this document.

2.1 **Importing demo project**

Follow the steps below:

1. Launch the e² studio and select the workspace directory.

   ![Figure 2-1 Select workspace](image)

   **Figure 2-1 Select workspace**

2. Select File → Import.

   ![Figure 2-2 File menu](image)

   **Figure 2-2 File menu**
3. Select Existing Projects into Workspace and click Next button.

![Select an import wizard](image)

**Figure 2-3** Select an import wizard

4. Select Select root directory, click Browse… button and select the demo project folder. Click Finish button to import the demo project.

![Import Project](image)

**Figure 2-4** Import Project
2.2 Building and debugging

Follow the steps below:

For more information on debugging with e² studio, refer to Chapter 5 in "e² studio User's Manual: Getting Started Guide" (R20UT4374).

1. Select [Build Project] in [Project] menu or click the Build icon  to build the project. In [Console] tab, if you can see "Build Finished" message that follows build log, the build is successful.

   You can see and change the current project with Launch Configuration  .
   After building, the firmware (.srec file) is generated in the "Debug" in the project directory.

2. Connect EK-RA4W1 to a PC.

3. Click the Debug icon  to launch the project in debug mode.
   After launching the project, the firmware is downloaded to EK-RA4W1.

4. Click the Resume icon on Debug Perspective to run the project.

5. After debugging the project, click the Terminate icon on Debug Perspective.
   Firmware of the project remains on the flash memory of RA4W1 even after termination and power off.

To perform the demonstration, it is recommended to use at least two EK-RA4W1; one board works as a Client and the other works as a Server.

NOTE: When the error indicating "No toolchain set or toolchain not integrated." occurs and building fails, open [Project]  [C/C++ Project Settings] and move to [C/C++ Build]  [Settings] [Toolchain] tag, then set the toolchain (9.3.1.20200408 or later).
3. How to make and configure new project

This chapter describes how to add Mesh Stack to a new project by using FSP Configuration in the e² studio.

3.1 Create a New Project

1. Launch e² studio and select [File]→[New]→[Renesas C/C++ Project]→[Renesas RA]. In New C/C++ Project dialog, select Renesas RA C/C++ Project and click on the Next button.

   ![Figure 3-1 Templates for New C/C++ Project](image)

2. Enter the project name and click on Next button. The project is named sample_appl in this document.

   ![Figure 3-2 New Renesas Executable Project](image)
3. Select the **Custom User Board (Any Device)** from **Board, R7FA4W1AD2CNG** from **Device**.

![Figure 3-3 Project Configuration (Board and Device)](image)

4. When making the MESH application on a **BareMetal** environment, choose **No RTOS**. When making the application on a **FreeRTOS** environment, choose **FreeRTOS**.

![Figure 3-4 Project Configuration](image)

5. Click **Next** button.
6. When making the MESH application on a BareMetal environment, choose **BareMetal -Minimal**. When making the application on a FreeRTOS environment, choose **FreeRTOS -Minimal- Static Allocation**.

![Figure 3-5 Project Configuration (Select Template)](image1)

7. Click **Finish** button. After a while, the project will be created.

![Figure 3-6 Project Overview](image2)
3.2 Heap and Stack configuration

To allocate enough memory size to use as the Mesh Stack, set heap and stack configuration as following in [Properties] of [BSP] tab on FSP configuration.

- [RA Common]→[Main stack size (bytes)] : 0x1400
- [RA Common]→[Heap size (bytes)] : 0x1000

![Figure 3-7  BSP Configuration](image)

The configuration macros listed in Table 3-1 of BSP are changed by the above configuration.

NOTE: When you use the Mesh Stack, please be sure to change the following configuration.

<table>
<thead>
<tr>
<th>Configuration and Macro</th>
<th>Default Value</th>
<th>Value for Mesh</th>
</tr>
</thead>
<tbody>
<tr>
<td>RA Common &gt; Main stack size (bytes)</td>
<td>0x400</td>
<td>0x1400</td>
</tr>
<tr>
<td>(BSP_CFG_STACK_MAINBYTES)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RA Common &gt; Heap size (bytes)</td>
<td>0</td>
<td>0x1000</td>
</tr>
<tr>
<td>(BSP_CFG_HEAPBYTES)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3.3 Clocks configuration

In [Clocks] tab of the FSP Configuration, select the clocks and set their clock frequency. To use the Mesh Stack, the following settings are required:

- System Clock (ICLK): 8MHz or over
- Peripheral module Clock A (PCLKA): 8MHz or over

Bluetooth LE Stack is optimized for the case that the clock frequency of both the ICLK and the PCLKA is 32MHz. Thus, it is recommended to set the clock configuration in which the clock frequency of both the ICLK and the PCLKA become 32MHz.

![Clocks Configuration Diagram](image-url)

**Figure 3-8 Clocks Configuration**
3.4 Add and configure MESH Stack

This section describes how to add / configure the MESH Stack into the MESH application. Click configuration.xml in the project and add / configure the MESH Stack in the [Stacks] tab on the FSP Configuration. The procedure about adding the MESH Stack is different for the BareMetal and the FreeRTOS environment. Section 3.4.1 describes the procedure for the BareMetal environment. Section 3.4.2 describes the procedure for the FreeRTOS environment. The MESH Stack configuration is common to the BareMetal and the FreeRTOS environment. The configuration is described in detail in section 3.4.3.

3.4.1 Add MESH Stack in BareMetal environment

1. Click New Stack and add Networking→BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) to HAL/Common. This driver includes some peripheral driver. The configuration for these peripherals are described in section 3.5.

![Figure 3-9 Add Bluetooth Bearer](image)

2. Click Add BLE Mesh OS Module box and select New→BLE Mesh OS on Baremetal (rm_mesh_os_baremetal).

![Figure 3-10 Add OS](image)
3. Click **Add BLE Mesh Timer Module** box and select **New**→**BLE Mesh Timer on Baremetal (rm_mesh_timer_baremetal)**.

![Figure 3-11 Add Timer](image1)

4. Click **Add BLE Network Driver** box and select **New**→**BLE Driver (r_ble_extended)**.

![Figure 3-12 Add Bluetooth LE Stack](image2)
5. Click **New Stack** and add the required model for your mesh application to **HAL/Common**. For example, if you want to use the Generic On Off Server model, choose **Networking → BLE Mesh Model Generic On Off Server**.

![Add Mesh Model Diagram]

**Figure 3-13. Add Mesh Model**

**NOTE:** If you are adding a second or subsequent model to the same element, click the Add BLE Mesh Access Module box and select **Use → g_rm_ble_access0 BLE Mesh Access (rm_ble_mesh_access)**.
3.4.2 Add MESH Stack in FreeRTOS environment

1. Click **New Thread** on the Threads area and add a New Thread. In this example, the New Thread is named **BLE_CORE_TASK**.

![Figure 3-14 Add BLE_CORE_TASK](image1)

2. Change Stack size to 0x3000[bytes]. Change Priority to 2.

![Figure 3-15 Stack size and Priority of BLE_CORE_TASK](image2)
3. Change FreeRTOS configurations as the following in BLE_CORE_TASK Properties tab.

<table>
<thead>
<tr>
<th>Configuration and Macro</th>
<th>Changed Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common &gt; General &gt; Minimal Stack Size (configMINIMAL_STACK_SIZE)</td>
<td>1024</td>
<td>128</td>
</tr>
<tr>
<td>Common &gt; General &gt; Use Mutexes (configUSE_MUTEXES)</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Common &gt; General &gt; Use Recursive Mutexes (configUSE_RECURSIVE_MUTEXES)</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Common &gt; General &gt; Enable Backward Compatibility (configENABLE_BACKWARD_COMPATIBILITY)</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Common &gt; Memory Allocation &gt; Support Dynamic Allocation (configSUPPORT_DYNAMIC_ALLOCATION)</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Common &gt; Memory Allocation &gt; Total Heap Size (configTOTAL_HEAP_SIZE)</td>
<td>11264</td>
<td>0</td>
</tr>
<tr>
<td>Common &gt; Timers &gt; Timer Queue Length (configTIMER_QUEUE_LENGTH)</td>
<td>32</td>
<td>10</td>
</tr>
<tr>
<td>Common &gt; Optional Functions &gt; xTimerPendFunctoinCall() Function (INCLUDE_xTimerPendFunctionCall)</td>
<td>Enabled</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

4. Click New Stack and add Networking→BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) to BLE_CORE_TASK. This driver includes some peripheral driver. The configuration for these peripherals are described in section 3.5.
6. Click **Add BLE Mesh OS Module** box and select **New → BLE Mesh OS on FreeRTOS (rm_mesh_os_freertos)**.

![Add OS](image)

**Figure 3-17  Add OS**

7. Click **Add BLE Mesh Timer Module** box and select **New → BLE Mesh Timer on FreeRTOS (rm_mesh_timer_freertos)**.

![Add Timer](image)

**Figure 3-18  Add Timer**
7. Click **Add BLE Network Driver** box and select **New** ➔ **BLE Driver (r_ble_extended_freertos)**.

![Figure 3-19 Add Bluetooth LE Stack](image)

8. Click **New Stack** and add the required model for your mesh application to **BLE_CORE_TASK**. For example, if you want to use Generic On Off Server model, choose **Networking** ➔ **BLE Mesh Model Generic On Off Server**.

![Figure 3-20 Add Mesh Model](image)

**NOTE:** If you are adding a second or subsequent model to the same element, click the **Add BLE Mesh Access Module** box and select **Use** ➔ **g_rm_ble_access0 BLE Mesh Access (rm_ble_mesh_access)**.
9. Add RTOS → FreeRTOS Heap4 to HAL/Common.

Figure 3-21  Add Heap4
3.4.3 Configure Mesh Stack

This section describes the configurations required for the e BLE Mesh Network Middleware on rm_ble_mesh module.

Select [BLE Mesh Bearer Platform (rm_mesh_bearer_platform)] on the [Stacks] tab and change the properties as shown in Table 3-3. For details on each property value, refer to "Renesas Flexible Software Package (FSP) User's Manual (R11UM0155)".

<table>
<thead>
<tr>
<th>Configuration and Macro</th>
<th>Default Value</th>
<th>Value for Mesh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of connections (MESH_BEARER_PLATFORM_CFG_RF_CONNECTION_MAXIMUM)</td>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>Maximum advertising data length (MESH_BEARER_PLATFORM_CFG_RF_ADVERTISING_DATA_MAXIMUM)</td>
<td>1650</td>
<td>31</td>
</tr>
<tr>
<td>Maximum advertising set number (MESH_BEARER_PLATFORM_CFG_RF_ADVERTISING_SET_MAXIMUM)</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>Maximum periodic sync set number (MESH_BEARER_PLATFORM_CFG_RF_SYNC_SET_MAXIMUM)</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

Set "1" to [Maximum number of connections], "31" to [Maximum advertising data length], "1" to [Maximum advertising set number], "1" to [Maximum periodic sync set number] respectively.

NOTE: Set the same values in the properties of the BLE Driver box as well.
Select [BLE Mesh (rm_ble_mesh)] on the [Stacks] tab and change the properties as shown in Table 3-4. For details on each property value, refer to “Renesas Flexible Software Package (FSP) User's Manual (R11UM0155)”.

**Table 3-4  Mesh Stack Configuration**

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Default Value</th>
<th>Value for Mesh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage→Block Number</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>Memory Pool→Memory Pool Size</td>
<td>0x4000</td>
<td>0x3000</td>
</tr>
</tbody>
</table>

The number of Data Flash Blocks used for storing mesh information
MIN: 1
MAX: 8

Set "6" to [Block number], "0x3000" to [Memory pool size].

**Figure 3-23  Mesh Stack Configuration (2)**
### 3.4.4 Other Mesh Stack configuration

The Mesh Stack has parameters that can be changed depending on each mesh network scale and each requirement for node. These parameters can be set with FSP Configuration and are reflected in "common_data.c" when generating code.

<table>
<thead>
<tr>
<th>Configuration and Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bearer → Network Interface Number</td>
<td>The number of bearers used for Mesh Network&lt;br&gt;<strong>MIN:</strong> 1&lt;br&gt;<strong>MAX:</strong> (1 + MESH_BEARER_PLATFORM_CFG_RF_CONNECTION_MAXIMUM)&lt;br&gt;First bearer is ADV bearer and subsequent bearers are GATT bearers which can establish connections concurrently. When this configuration is set to 1, only ADV bearer can be used.</td>
</tr>
<tr>
<td>Bearer → Provisioning Interface Number</td>
<td>The number of bearers used for Provisioning&lt;br&gt;<strong>MIN:</strong> 1&lt;br&gt;<strong>MAX:</strong> 2&lt;br&gt;When this configuration is set to 1, only PB-ADV bearer can be used. When this configuration is set to 2, PB-ADV bearer and one PB-GATT bearer can be used.</td>
</tr>
<tr>
<td>Provisioning → Unprovisioned Device Beacon Timeout in Milliseconds</td>
<td>Transmission interval of Unprovisioned Device Beacon [msec]&lt;br&gt;<strong>MIN:</strong> 20&lt;br&gt;When only PB-ADV is used, Unprovisioned Device Beacon is transmitted at the intervals of this configuration. When only PB-GATT is used, Connectable Advertising PDU is transmitted at the intervals of this configuration. When both PB-ADV and PB-GATT are used, Unprovisioned Device Beacon and Connectable Advertising PDU are transmitted alternately at the intervals of this configuration.</td>
</tr>
<tr>
<td>Network → Network Cache Size</td>
<td>The maximum number of nodes that Network Message Cache can store&lt;br&gt;<strong>MIN:</strong> 2&lt;br&gt;If message from new node is received when Network Message Cache stores cache information for the maximum number of nodes, cache information for the oldest node will be removed.</td>
</tr>
<tr>
<td>Network → Network Sequence Number Cache Size</td>
<td>The number of SEQ number that Network Message Cache can store for each node&lt;br&gt;<strong>MIN:</strong> 32</td>
</tr>
<tr>
<td>Network → Maximum Number of Subnet</td>
<td>Maximum number of subnet information such as Network Key and NID&lt;br&gt;<strong>MIN:</strong> 1</td>
</tr>
<tr>
<td>Network → Maximum Number of Device Key</td>
<td>Maximum number of Device Key&lt;br&gt;<strong>MIN:</strong> 1&lt;br&gt;When Configuration Client Model is not used, it is enough to set this configuration to 1.</td>
</tr>
</tbody>
</table>

**Table 3-5 BLE Mesh (rm_ble_mesh) Configuration and Variable name**
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network → Proxy Filter List Size&lt;br&gt;(proxy_filter_list_size)&lt;br&gt;*Default: 2</td>
<td>Maximum number of addresses that can be added to each Proxy List&lt;br&gt;MIN: 1</td>
</tr>
<tr>
<td>Network → Network Sequence Number Block Size&lt;br&gt;(net_sequence_number_block_size)&lt;br&gt;*Default: 2048</td>
<td>Distance between SEQ number for writing to Data Flash memory&lt;br&gt;MIN: 1&lt;br&gt;SEQ number will be saved to Data Flash at the distance of this configuration. When MCU is reset, SEQ number resumes from the next distance.&lt;br&gt;e.g.) When this configuration is 2048, SEQ number is written to Data Flash every time SEQ number reaches a multiple of 2048 such as 2048 and 4096. If MCU is reset when SEQ number is 3000, SEQ number resumes from 4096. The shorter this configuration is, the more frequently SEQ number is written to Data Flash. The longer this configuration is, the bigger SEQ number is skipped after resetting MCU.</td>
</tr>
<tr>
<td>Network → Network Transmit Count for Network Packets&lt;br&gt;(net_tx_count)&lt;br&gt;*Default: 1</td>
<td>Default value of Network Transmit Count state&lt;br&gt;MIN: 0&lt;br&gt;MAX: 7</td>
</tr>
<tr>
<td>Network → Network Interval Steps for Network Packets&lt;br&gt;(net_tx_interval_steps)&lt;br&gt;*Default: 4</td>
<td>Default value of Network Transmit Interval Steps state&lt;br&gt;MIN: 0&lt;br&gt;MAX: 31</td>
</tr>
<tr>
<td>Network → Network Transmit Count for Relayed Packets&lt;br&gt;(net_relay_tx_count)&lt;br&gt;*Default: 0</td>
<td>Default value of Relay Retransmit Count state&lt;br&gt;MIN: 0&lt;br&gt;MAX: 31</td>
</tr>
<tr>
<td>Network → Network Interval Steps for Relayed Packets&lt;br&gt;(net_relay_tx_interval_steps)&lt;br&gt;*Default: 9</td>
<td>Default value of Relay Retransmit Interval Steps state&lt;br&gt;MIN: 0&lt;br&gt;MAX: 31</td>
</tr>
<tr>
<td>Network → Proxy ADV Network ID Timeout for Each Subnet in Milliseconds&lt;br&gt;(proxy_subnet_netid_adv_timeout)&lt;br&gt;*Default: 100</td>
<td>Transmission interval of Proxy Advertisement with Network ID [msec]&lt;br&gt;MIN: 20</td>
</tr>
<tr>
<td>Network → Proxy ADV Node Identity Timeout for Each Subnet in Milliseconds&lt;br&gt;(proxy_subnet_nodeid_adv_timeout)&lt;br&gt;*Default: 300</td>
<td>Transmission interval of Proxy Advertisement with Node Identity [msec]&lt;br&gt;MIN: 20</td>
</tr>
<tr>
<td>Network → Proxy ADV Node Identity Overall Time Period in Milliseconds&lt;br&gt;(proxy_nodeid_adv_timeout)&lt;br&gt;*Default: 60</td>
<td>Transmission period of Proxy Advertisement with Node Identity [sec]&lt;br&gt;MIN: 1</td>
</tr>
<tr>
<td>Network → Maximum Number of Queued Messages for Transmission&lt;br&gt;(net_tx_queue_size)&lt;br&gt;*Default: 64</td>
<td>Size of transmission queue for Network PDUs&lt;br&gt;MIN: 2</td>
</tr>
<tr>
<td>Transport → Maximum Number of LPN&lt;br&gt;(maximum_lpn)&lt;br&gt;*Default: 1</td>
<td>Maximum number of Low Power Nodes that Friend Node can establish Friendship with&lt;br&gt;MIN: 1</td>
</tr>
<tr>
<td>Transport → Replay Protection Cache Size&lt;br&gt;(replay_cache_size)&lt;br&gt;*Default: 10</td>
<td>Size of Replay Protection Cache&lt;br&gt;MIN: 2</td>
</tr>
<tr>
<td>Transport → Reassembled Cache Size&lt;br&gt;(reassembled_cache_size)&lt;br&gt;*Default: 8</td>
<td>Size of reception message cache of Segmentation and Reassembly (SAR)&lt;br&gt;MIN: 2</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Transport→Friend Poll Retry Count (frnd_poll_retry_count)</td>
<td>The number of times to retry Friend Poll message when Low Power Node does not receive Friend Update message</td>
</tr>
<tr>
<td>Transport→Maximum Number of Segmentation and Reassembly (maximum_ltrn_sar_context)</td>
<td>The number of contexts of Segmentation and Reassembly (SAR) mechanism used for transmitting and receiving Segmented Message</td>
</tr>
<tr>
<td>Transport→Lower Transport Segment Transmission Timeout in Milliseconds (ltrn_rtx_timeout)</td>
<td>Retransmission interval of segmented message [msec]</td>
</tr>
<tr>
<td>Transport→Lower Transport Segment Re-Transmission Count (ltrn_rtx_count)</td>
<td>The number of times to retransmit segmented message</td>
</tr>
<tr>
<td>Transport→Lower Transport Acknowledgement Timeout in Milliseconds (ltrn_ack_timeout)</td>
<td>Transmission interval of Segmented Acknowledgement message [msec]</td>
</tr>
<tr>
<td>Transport→Lower Transport Incomplete Timeout in Milliseconds (ltrn_incomplete_timeout)</td>
<td>Cancel timeout time of receiving segmented message [sec]</td>
</tr>
<tr>
<td>Transport→Friendship Receive Window (frnd_receive_window)</td>
<td>Reception windows size of Low Power Node [msec]</td>
</tr>
<tr>
<td>Transport→Maximum Number of Friend Message Queue (maximum_friend_message_queue)</td>
<td>Size of Message Queues for each Low Power Node</td>
</tr>
<tr>
<td>Transport→Maximum Number of Friend Subscription List (maximum_friend_subscription_list)</td>
<td>Maximum number of Friend Subscription Lists for each Low Power Node</td>
</tr>
<tr>
<td>Transport→Friend Clear Confirmation Timeout in Milliseconds (lpn_clear_retry_timeout_initial)</td>
<td>Retransmission interval of Friend Clear message when Low Power Node does not receive Friend Clear Confirmation message</td>
</tr>
<tr>
<td>Transport→Friend Clear Retry Count (lpn_clear_retry_count)</td>
<td>The number of times to retry Friend Clear message when Low Power Node does not receive Friend Clear Confirmation message</td>
</tr>
<tr>
<td>Transport→Friendship Retry Timeout in Milliseconds (tm_frndreq_retry_timeout)</td>
<td>Transmission period of Friend Request message [msec]</td>
</tr>
<tr>
<td>Access→Maximum Number of Element (maximum_access_element_num)</td>
<td>Maximum number of Elements</td>
</tr>
<tr>
<td>Access→Maximum Number of Model (maximum_access_model_num)</td>
<td>Maximum number of Models</td>
</tr>
<tr>
<td>Access→Maximum Number of Application (maximum_application)</td>
<td>Maximum number of Application Keys</td>
</tr>
<tr>
<td>Access→Maximum Number of Virtual Address (maximum_virtual_address)</td>
<td>Maximum number of Virtual Address</td>
</tr>
</tbody>
</table>
### Maximum Number of Non-Virtual Address

- **(maximum_non_virtual_address)**
  - **Default**: 8
  - **Description**: Maximum number of Non-virtual Address (Unicast Address or Group Address)

### Maximum Number of Transition Timers

- **(max_num_transition_timers)**
  - **Default**: 5
  - **Description**: The number of State Transition Timers for models

### Maximum Number of Periodic Step Timers

- **(max_num_periodic_step_timers)**
  - **Default**: 5
  - **Description**: The number of Periodic Publication Timers for models

### Config Server Secure Network Beacon Interval

- **(config_server_snb_timeout)**
  - **Default**: 10
  - **Description**: Transmission Interval of Secure Network Beacon [sec]

### Maximum Number of Health Server Instance

- **(maximum_health_server_num)**
  - **Default**: 2
  - **Description**: Maximum number of Health Server Model

### Maximum Number of Light Lightness Controller Server Instance

- **(maximum_light_lc_server_num)**
  - **Default**: 1
  - **Description**: Maximum number of Light Lightness Controller Server Model

### Company ID

- **(default_company_id)**
  - **Default**: 0x0036
  - **Description**: Company ID registered with Bluetooth SIG

- ** MIN**: 0x0000
  - **MAX**: 0xFFF

### Product ID

- **(default_product_id)**
  - **Default**: 0x0001
  - **Description**: Product ID assigned by vendor

- ** MIN**: 0x0000
  - **MAX**: 0xFFFF

### Vendor ID

- **(default_vendor_id)**
  - **Default**: 0x0100
  - **Description**: Product Version ID assigned by vendor

- ** MIN**: 0x0000
  - **MAX**: 0xFFFF

### Packet Bitfield

- **(p_logging_cfg->packet_bitfield)**
  - **Default**: 0
  - **Description**: Get packet-related log

### Module Info Bitfield

- **(p_logging_cfg->module_info_bitfield)**
  - **Default**: 0
  - **Description**: Get module-related log

### Generic Log Bitfield

- **(p_logging_cfg->generic_log_bitfield)**
  - **Default**: 0
  - **Description**: Get generic log

### Logging Function

- **(p_logging_cfg->p_logging_func)**
  - **Default**: logging_function
  - **Description**: Callback when logging

---

### Table 3-6 BLE Mesh Provision (rm_ble_mesh provision) Configuration and Variable name

<table>
<thead>
<tr>
<th>Configuration and Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provision Capabilities→Number of Elements (num_elements)</td>
<td>For detail, refer to Mesh Profile Specification.</td>
</tr>
<tr>
<td>Provision Capabilities→Supported Algorithms (supported_algorithms)</td>
<td>For detail, refer to Mesh Profile Specification.</td>
</tr>
<tr>
<td>Provision Capabilities→Public Key Type (supported_pubkey)</td>
<td>For detail, refer to Mesh Profile Specification.</td>
</tr>
<tr>
<td>Provision Capabilities→Static OOB Type (supported_soob)</td>
<td>For detail, refer to Mesh Profile Specification.</td>
</tr>
</tbody>
</table>
Table 3-7 BLE Mesh Network (rm_ble_mesh_network) Configuration and Variable name

<table>
<thead>
<tr>
<th>Configuration and Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callback (p_callback)</td>
<td>Callback from Network process</td>
</tr>
<tr>
<td>*Default: 1</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-8 BLE Mesh Upper Trans (rm_ble_mesh_upper_trans) Configuration and Variable name

<table>
<thead>
<tr>
<th>Configuration and Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Callback (p_callback)</td>
<td>Callback Upper Transport process</td>
</tr>
<tr>
<td>*Default: NULL</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-9 BLE Mesh Access (rm_ble_mesh_access) Configuration and Variable name

<table>
<thead>
<tr>
<th>Configuration and Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Descriptor (p_element_descriptor-&gt;loc)</td>
<td>where the element is placed</td>
</tr>
<tr>
<td>*Default: 0</td>
<td></td>
</tr>
<tr>
<td>Element Number (element_number)</td>
<td>The number to identify the element</td>
</tr>
<tr>
<td>*Default: 0</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-10 BLE Mesh Bearer Platform (rm_mesh_bearer_platform) Configuration and Variable name

<table>
<thead>
<tr>
<th>Configuration and Variable name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Device Address Type (device_address_type) | BD address type  
0: Public address  
1: Random address |
| *Default: 1                     |                                                                            |
| GATT Server Callback Number (gatt_server_callback_num) | The number of callbacks to be registered  
MIN: 1  
MAX: 15 |
| *Default: 15                    |                                                                            |
| GATT Client Callback Number (gatt_client_callback_num) | The number of callbacks to be registered  
MIN: 1  
MAX: 15 |
| *Default: 15                    |                                                                            |
| Vender Specific Callback (vender_specific_callback) | Callback of completing BD address setting with open API of Bearer Platform |
| *Default: NULL                  |                                                                            |
3.5 Add and configure related module

The MESH Stack uses the following peripherals to perform MESH communication.

### Table 3-11 Related peripherals

<table>
<thead>
<tr>
<th>Item</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth Low Energy Driver (r_ble_extended or r_ble_extended_FREertos)</td>
<td>Bluetooth Low Energy communication</td>
</tr>
<tr>
<td>General PWM Timer Driver (r_gpt)</td>
<td>Timer (g_timer0) for Bluetooth Mesh Stack</td>
</tr>
<tr>
<td>Low-Power Flash Driver (r_flash_lp)</td>
<td>Timer (g_timer1) for Bluetooth LE Stack</td>
</tr>
<tr>
<td>Low-Power Flash Driver (r_flash_lp)</td>
<td>Store Bonding information etc.</td>
</tr>
<tr>
<td>Interrupt Controller Unit Driver (r_icu)</td>
<td>Interrupt (g_external_irq0) from BLE(H/W)</td>
</tr>
<tr>
<td>Low Power Modes Driver (r_lpm)</td>
<td>Interrupt (g_ble_sw_irq) from switch(H/W)</td>
</tr>
<tr>
<td>Serial Communication Interface Driver (r_sci_uart)</td>
<td>Serial communication</td>
</tr>
</tbody>
</table>

This section describes how to configure related peripherals (timers, interrupt) for MESH Stack which added in previous section. Procedure describes in this section is common to BareMetal and FreeRTOS environment.
3.5.1  r_gpt (g_timer0)

1. Click **Add Timer Driver** box and select **New → Timer, General PWM (r_gpt).**

![Figure 3-24  Add GPT for Bluetooth Mesh Stack](image1)

2. Set **Overflow/Crest Interrupt Priority** of **g_timer0 Timer, General PWM (r_gpt)** as **Priority 3** on **Properties** tab.

![Figure 3-25  GPT configuration for Bluetooth Mesh Stack](image2)
3.5.2  r_flash_lp
Configure as following.

1. Set the Data Flash Background Operation of `g_flash0 Flash (r_flash_lp)` as Disabled on Properties tab.

![Figure 3-26 Flash configuration](image-url)
3.5.3  r_icu (g_external_irq0)
1. Set Pin Interrupt Priority of g_external_irq0 External IRQ (r_icu) as the followings.

   - **BareMetal environment**
     Priority 0 on Priority.

     ![Figure 3-27 ICU configuration (BareMetal Environment)]

   - **FreeRTOS environment**
     Priority 1 on Priority. Because it is the highest priority used by the FreeRTOS kernel.

     ![Figure 3-28 ICU configuration (FreeRTOS Environment)]
3.5.4 r_gpt (g_timer1)

1. Click Add GPT Driver box and select New  Timer, General PWM (r_gpt).

![Add GPT for Bluetooth LE Stack](image1)

Figure 3-29  Add GPT for Bluetooth LE Stack

2. Set Overflow/Crest Interrupt Priority of g_timer1 Timer, General PWM (r_gpt) as Priority 2 on Properties tab.

![GPT configuration for Bluetooth LE Stack](image2)

Figure 3-30  GPT configuration for Bluetooth LE Stack
3.5.5 r_icu (g_ble_sw_irq)
If you use a switch on EK-RA4W1, set the configuration as the followings.

1. Click New Stack and add **Input→External IRQ Driver (r_icu)** to HAL/Common.

   ![Figure 3-31 Add ICU Driver](image)

   **Figure 3-31 Add ICU Driver**

2. Set **g_external_irq1 External IRQ (r_icu)** as the following.

   - [Name] : g_ble_sw_irq
   - [Channel] : 4
   - [Trigger] : Falling
   - [Callback] : Callback_ble_sw_irq
   - [Pin Interrupt Priority] : Priority 2

   ![Figure 3-32 ICU Driver configuration](image)

   **Figure 3-32 ICU Driver configuration**
3.5.6  r_sci_uart
If you use the Command Line Interface (CLI) to perform serial communication with the EK-RA4W1, set the configuration as the following.

3.5.6.1 Related source files
Source files related to the CLI are installed under ./src/app_lib in this demo project. The user can add the CLI functionality by copying the app_lib directory from this demo project to another project.

3.5.6.2 Configurations of SCI
Open the FSP configuration of user’s project and select the Stacks tab. Add New Stack→Connectivity→UART (r_sci_uart) to HAL/Common. Modify configuration of the added r_sci_uart as the following.

- [General]→[Channel] : 4
- [Interrupts]→[Callback] : user_uart_callback_ble_cli
- [Interrupts]→[xxx Interrupt Priority] : Priority 2
- [Pins]→[TXD] : P205
- [Pins]→[RXD] : P206

Figure 3-33   UART configuration
3.5.6.3 Designating module name

Edit the value of BLE_UART_INSTANCE macro in app_lib/r_ble_console.c if the module name of the r_sci_uart has been changed from g_uart0.

```
/************************************************************
 * Macro definitions
 ************************************************************/
#define BLE_TX_BUFSIZE  (180)
#define BLE_UART_INSTANCE  (g_uart0)
```

Code 1. BLE_UART_INSTANCE macro

3.5.6.4 Serial data output of UART

The serial data output of UART can be invoked by using the `R_BLE_CLI_Printf()` function. `R_BLE_CLI_Printf()` function can generate formatted character lines similar to the `printf()` function.

Table 3-12 Syntax of `R_BLE_CLI_Printf()`

<table>
<thead>
<tr>
<th>Function Name</th>
<th>R_BLE_CLI_Printf</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td><code>void R_BLE_CLI_Printf(const char *format, …);</code></td>
</tr>
<tr>
<td>Return</td>
<td><code>void</code></td>
</tr>
</tbody>
</table>
| Arguments     | `const char *format` Designate a constant character line including formats  
```
... Variable number of arguments represented by formats can be designated.
```

3.5.7  r_lpm
If you use the low power mode of the MCU, configure as following.

2. Click **New Stack** and add **Power→Low Power Modes (r_lpm)** to **HAL/Common**.

![Figure 3-34   Add LPM](image)
3.6 Generate Code

Click [Generate] button on the FSP Configuration. API header, library, code, data, and the configuration files of each modules are generated in “ra”, "ra_gen", “ra_cfg” folders of the project.

Figure 3-35 Result of Code Generation

3.7 Building and debugging

Refer to section 2.2.
4. How to Implement Mesh Applications

Regarding how to implement mesh applications using the Mesh Stack, refer to "RA4W1 Group Bluetooth Mesh Development Guide" (R01AN5849).
5. Appendix

5.1 Program Size

Table 5-1 shows the program size of demo project.

Table 5-1  Program Size

<table>
<thead>
<tr>
<th>Project</th>
<th>ROM Size</th>
<th>RAM Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>ekra4w1_mesh_cli_client_baremetal</td>
<td>510KB</td>
<td>52KB</td>
</tr>
<tr>
<td>ekra4w1_mesh_cli_server_baremetal</td>
<td>477KB</td>
<td>53KB</td>
</tr>
<tr>
<td>ekra4w1_mesh_client_baremetal</td>
<td>334KB</td>
<td>48KB</td>
</tr>
<tr>
<td>ekra4w1_mesh_client_freertos</td>
<td>348KB</td>
<td>82KB</td>
</tr>
<tr>
<td>ekra4w1_mesh_server_baremetal</td>
<td>335KB</td>
<td>48KB</td>
</tr>
<tr>
<td>ekra4w1_mesh_server_freertos</td>
<td>349KB</td>
<td>82KB</td>
</tr>
</tbody>
</table>
**Trademark and Copyright**

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such marks by Renesas Electronics Corporation is under license. Other trademarks and registered trademarks are the property of their respective owners.

RA4W1 Group Bluetooth Mesh Stack uses the following open source software.

- **crackle**: AES-CCM, AES-128bit functionality
  
  **BSD 2-Clause License**

  Copyright (c) 2013-2018, Mike Ryan
  All rights reserved.

  Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

  * Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
  
  * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Feb. 25, 2022</td>
<td>- First edition</td>
</tr>
<tr>
<td>1.01</td>
<td>Apr. 27, 2022</td>
<td>P.21 Changed Total Heap Size from 10240 to 11264.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated attached demo project.</td>
</tr>
<tr>
<td>1.03</td>
<td>Aug. 29, 2022</td>
<td>P. 8 P.25 Updated software requirements. Added a note to set the same value to the properties of the BLE Mesh Bearer Platform and BLE Driver box. Updated attached demo project.</td>
</tr>
<tr>
<td>1.04</td>
<td>Oct. 26, 2022</td>
<td>P. 8 Updated software environment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated attached demo project.</td>
</tr>
<tr>
<td>1.05</td>
<td>Dec. 16, 2022</td>
<td>P. 8 P. 27 Updated software environment. Updated FSP Configuration parameters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Updated attached demo project.</td>
</tr>
</tbody>
</table>
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
   A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
   The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.

3. Input of signal during power-off state
   Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
   Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
   After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
   Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.).

7. Prohibition of access to reserved addresses
   Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
   Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, condition, copying or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   - “Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - “High Quality”: Transportation equipment (automobiles, trains, ships, etc.); nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS PRODUCTS WILL BE INVISIBLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation, and any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reproduced, reprinted or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

---

**Corporate Headquarters**

TOYOSU FORESIA, 3-2-24 Toyosu, Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

---

**Trademarks**

Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

---

**Contact information**

For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit: www.renesas.com/contact.